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1. Explain Spelling and Grammar Check. 
 

We can do Spelling and Grammar Check in following ways. 

i. Automatically correct spelling and grammar. 

ii. Automatically check spelling and grammar as we type. 

iii. Check spelling and grammar all at once. 

iv. Check the spelling and grammar to text in another language. 

 

Automatically check spelling and grammar as we type: 

i. Turn on automatic spelling and grammar checking 

ii. To start checking spelling and grammar, just type in the document.  The 

spelling and grammar checkers use wavy red underlines indicate possible 

spelling errors and wavy green underlines to indicate possible grammatical 

errors. 

 

Do one of the following: 

i. To choose the error we want to correct, right-click a word with a wavy 

underline. 

ii. To find the next error in the document, double-click the Spelling and 

Grammar Status icon on the status bar. 

On the shortcut menu do one of the following: 

i. Click the spelling or grammatical correction we want. 

ii. If we are correcting a spelling error, click spelling to use additional spelling 

options 

iii. If we are correcting a grammatical error, click Grammar to use additional 

grammar options, or use additional grammar options, or click about this 

Sentence for a detailed explanation of the error. 

       Check spelling and grammar all at once: 

 By default, Microsoft Word checks both spelling and grammar.  If we 

want to check spelling only, click Options on the Tools menu, click the 

Spelling and Grammar tab, clear the Check grammar with spelling 

check box, and then click ok. 

 Click spelling and grammar on the standard toolbar. 

 When word finds a possible spelling or grammatical error, make our 

changes in the spelling and grammar dialog box. 

 We can also edit a spelling or grammatical error directly in the 

document.  Just type our correction, and then click Resume in the 



Spelling and Grammar dialog box.  For detailed explanation, click 

Office Assistant in a dialog box. 

 

 

 

2) Explain Mail Merge in detail? 
 

Word‟s mail merge feature is used to combine data source with main 
documents, which can be a word database file that contains the information 

 

Mail Merge performed by three basic steps: 

o Creating the main document 

 

o Creating the data source. 

o Merging the data source and the main document. 

o Creating the main document 

o Which contains the generic information that we want to repeat in each 

form letter, mailing label, envelope, or catalog. 

 

The steps to create a main document are: 

 Select the Mail Merge option from the Tools menu.  The Mail Merge 

Helper dialog box is displayed. 

 Click on the Create button in the Main document area.  The create Drop-

Down list is displayed. 

 Select Form letters from the list of displayed options.  The Microsoft 

Word Dialog Box is displayed. 

 Click on the Active Window button to confirm that the currently active 

document is to be the main document, or click on the new main Document 

button to open a new document as the main document. 

 Once the main document is created, the Mail Merge Helper dialog box is 

reactivated, displaying the type of merge and the path of the main 

document under the main document heading. 

 

3) Write the Features of Tally? 
Tally, being a user friendly business accounting software, allows entry of data in the 

form of vouchers, and generation of reports.  Reports could be generated at any point of 

time using Tally.  Performing analysis o past and present data is another powerful feature 

of Tally.  It has the following features: 

 

1. Accounting without codes: 

 

Tally is a codeless Accounting system. 

 

2. Comprehensive Accounting system: 

 

a. Tally is a complete accounting system. 



b. It handles different types of vouchers.  Example: payment, receipt, journals etc. 

c. We get all the primary books of accounts like cashbook, bankbook, cash flow, 

fund flow etc. 

 

3. Flexible classification of accounting: 

 

Tally by default created 28 predefined groups as per mercantile accounting 

convention.  Of these 9 primary groups are for balance sheet items and 6 groups are 

for profit and loss. 

 

4. General ledger: 

 

Tally maintains details of all ledgers defined by us.  It follows the concept of single 

ledger system.  This includes real, personal and nominal accounts. 

 

. 

4) How will you create a company? 
 

Creating a company involves – typing the name of the company, address tax 

numbers, financial year from etc.  A company can be created from company info menu.  

 To create a company, select create or press C from company info menu.  

Company creation screen will be created. 

 In the Creation screen first we can type the name of the company.  It is a 

compulsory field. 

 Type the Address of the company. This is an optional field; we can leave 

blank by pressing enter key.  Multi line address can be typed. 

 If the company has an Income tax number, local sales tax number, and an 

inter-state number it can be typed.  These fields are also optional. 

 The Maintain option allows us to specify the method of maintaining the 

accounts.  There are 3 options in it. 

 Accounts only – maintains only the financial accounts of the company. 

 Accts-cum-Inv – maintain both financial account and Inventory of the company. 

 Inventory only – maintain only the inventory accounts of the company. 

a. Type the starting date of financial year of the company.  Generally it will star 

from 1
st
 of April. 

b. Under the option books Beginning From field, type the actual date from which 

the accounts of the company has to be maintained.  Generally, Financial year 

from and Books Beginning from date will be the same. 

c. There is a provision to give a security control b giving the name of 

administrator and a password.  

d. Tally helps us to use the Multi-currency Accounting system. 

 

 

 

 

 



 

 

5) What are the characteristics of computer? 
 

  The important Characteristics of a computer are: 

 

i. High speed 

ii. Large memory (or) storage 

iii. Reliability and Accuracy 

iv. Versatility (or) Flexibility 

v. Automation 

vi. Diligence or Attentiveness 

 

i. High speed 

  The computer is a very high-speed device capable of performing 

operations at very high speed and with great accuracy.  The unit of speed is 

microseconds, the nanosecond and pico second. 

 

ii. Large memory (or) storage 

  The Computer is capable of storing a very large amount of data.  It 

receives data instantaneously without any error, when required.  The internal memory of 

the computer is used to store a certain amount of information.  The data needs to be 

stored on auxiliary storage device, usually magnetic tape or disk. 

 

iii. Reliability and Accuracy 

  The accuracy of computers is consistently high and the data stored in it is 

highly reliable. 

 

iv. Versatility or Flexibility 

  Computers are capable of performing any task.  For example, a task such 

as preparing a payroll or controlling the flow of traffic can be performed. 

 

v. Automation 

  The computers do the calculations or manipulation of the data 

automatically by using instructions.  The instructions not only relate to arithmetic 

operations such as multiplication, division, etc but also logical decision such as right or 

wrong. 

 

vi. Diligence or Attentiveness 

  A computer does not suffer from the human traits of tiredness and lack of 

concentration. 

Some peculiar characteristics of a computer are: 

1. Perform complex and repetitive calculations rapidly and 

accurately. 

2. Store large data and information 

3. Make decisions 



4. Provide information 

5. Draw and print graph 

6. Interact with the user through the terminals 

7. Computers do not have the capacity to think on their own. 

 

6) Explain computer Generations. 
 

Generations of computers  

First Generation Computers (1946-1955) 

 

  ENIAC (Electronic Numerical Integrator and Calculator) was the world 

first electronic computer.  A team at the University of pennysylvania led by Mauchely 

and J.P.Eckert in 1946 completed it.  The valves were relatively large and each was able 

to hold only a single bit.  IBM AND REMINGTON built it. 

 

  Example: IBM 650, UNIVAC IBM 701 

  Advantages: Vacuum tubers were used as electronic components. 

  Disadvantages:  

I. Large size 

II. Heat Generation 

III. Unreliability 

IV. Constant maintenance required 

V. Very Costly 

 

Memory: Electric Static tubes 

Storage: Paper tape, punched card 

Software: Machine coded language 

 

Second Generation Computers (1956-1965) 

 

  By late 1950, transistors replace vacuum tubes; they characterized the 

second generation computers.  These computers became much smaller in size, faster in 

processing and we can use larger volume of data.  They can store and retrieve data very 

easily. 

 

  Memory: Magnetic core 

  Storage: Magnetic tape, disk, and drum cards 

Software: Assembly language 

  Special Features: Monitor 

Advantages: 

a. Smaller size 

b. Less heat generation 

c. More reliable, faster 

Disadvantages: 
 Air conditioning and maintenance required. 

 



Third Generation Computers (1965-1970) 

  The Invention of Integrator Circuitry led to the improvements in 

Secondary storage devices, Input and Output devices.  They were 10,000 times better 

than that of first generation computers. 

 

  Memory: Magnetic cores and others 

  Storage: Extended core, storage VDU‟s for interface 

Software: Multi tasking Multi programming various languages like 

BASIC, PASCAL, FORTRAN, DBASE, AND FOXBASE. 

   

Advantages: 

I. Smaller size  

II. It uses Integrated Chips 

III. Lower heat generation and power dissipation 

 

Fourth Generation Computers (1971-1995) 

 

  The development of “very large scale integrated circuit”, commonly 
known as „Micro chips‟, let to the Fourth Generation computers.  This period saw a grater 

trend in high-level languages.  All these models make use of microprocessors, standard 

storage and Input/Output devices. 

 

 

Memory: Semiconductor memory 

  Storage: High capacity and compact 

Software: Virtual storage, database and 4GLike oracle, sybase 

  Special Features: PCs, Laptops, Mini, Micro and Super computers. 

Advantages: 

i. No air conditioning  

ii. Minimal maintenance 

iii. High component density 

iv. Cheapest 

 

Fifth Generation Computers (1995 onwards) 

 

 Artificial Intelligence “Knowledge Processing” is the concept behind 5GLs.  
They can solve a problem similar and near equivalent to human brains.  They can process 

non-numerical information such as pictures, graphics etc. 

 

 

Memory: High-speed memory 

  Storage: User-friendly Input and Output devices 

Software: New languages and packages like PROLOG, LISP, AND 

SIMULA. 

Advantages: 

i. It is user-friendly 



ii. Very high speed and could handle any event from numerical 

calculation to decision-making process 

iii. Robotics is the masterpiece in the study of AI, which makes 

computer think like man. 

iv. It introduces networking concepts, and usage of relational database 

management system. 

 

 

 

7) Write about inserting a Microsoft Excel worksheet or chart into a 

Word document. 
 

Word provides several ways to insert Microsoft Excel data into a Word document.  

For example, we can easily copy and paste a worksheet or chart.  Or we can insert the 

worksheet or chart as a linked object the main differences between linking and 

embedding are where the data is stored and how it is updated after we place it in the 

document. 

 

Linked worksheet: 

 A linked worksheet or chart appears in our document, but its information is stored 

in the original Excel workbook.  Whenever we edit the data in Excel word can 

automatically update the worksheet or chart in our document. 

 Linking is useful when we want to include information that is maintained 

independently, such as data collected by a different department, and when we need to 

keep that information in Word up-to-date. 

 Because the linked data is stored in another location, linking can also help 

minimize the file size or our word document. 

 

Embedded worksheets: 

 An embedded worksheet or chart stores its information directly in the word 

document.  We can create an embedded object from an existing Microsoft Excel 

worksheet or chart. Or we can create a new embedded 

Microsoft Excel worksheet or chart.  To edit the embedded object, just double-

click it to star Excel, make our changes, and then return to word.  We can embed an 

existing worksheet or chart, or start form scratch by embedding a new, blank worksheet 

or chart. 

 Because the information is totally contained in one word document, embedding is 

useful when we want to distribute an online version of our document to people who don‟t 
have access to independently maintained worksheet or charts. 

 

8) Explain purchase orders- stock vouchers: 
 

Tally provides us to produce purchase orders from the system.  Purchase orders 

may be produced, printed and sent to suppliers.  Goods received are linked, with the 

Post and invoices.  Outstanding purchase orders should be monitored. 

 



Creation of purchase orders: 

 Purchase order details will also depend on configuration settings. 

 

 From Gateway of Tally > select voucher Entry > select Purchase Order. 

 

To configure stock item settings press F12. 

e. Advanced Usage: This section deals with the additional fields we 

would input during the creation of a stock item. 

f. Part No: This is option.  To give part number for the item to identify 

them in certain industries Example:  In automation industry, various 

parts are known by their number. 

g. Alias: We are allowed to give aliases for the part number. 

h. Description: Give a description of the stock item that would appear in 

our invoices. 

i. Category: Classify stock items into stock categories. Modify 

previously created stock items to assign them to stock categories. 

j. Remarks: This is to identify the products or its usage when we look at 

its details. 

k. Alternate units: This is another unit, apart from the main unit, that we 

can use for the stock item.  This is useful when we need to deal in 

different units at different times. 

l. Enter Standard Rates: If we wish to specify standard purchase and 

sales rates for the item, select yes. 

m. Costing method: Select the method of valuation for the entry.  

 

9) What are the uses of tally in financial and Inventory management? 
 

Uses of Tally in financial management: 

 

Concurrent open companies: 

  We can get reports form several companies by opening several companies 

concurrently.  We can view the comparative figures of various companies and can get a 

consolidated report of several companies, branch of divisions. 

 

Multiple currencies: 

  Tally allows using multiple currencies.  It is useful for importers, 

exporters, and MNC‟s. 
 

Unlimited period: 

  Tally has broken the concept of fixed financial period.  Data of several 

years may be kept together and we can take any report for any period. 

 

Cash and fund flows: 

  Tally provides cash and fund flow statements.  They track the movement 

of cash and funds in the company. 

 



Percentage based reporting: 

  It provides percentage based reporting on financial statements. 

 

Budgeting and control: 

  Tally provides excellent budgeting option to set goals. 

 

Graph: 

  Bar charts of all financial reports may be viewed on screen along with the 

data in Tally. 

 

Uses of Tally in Inventory management: 

1. Flexible invoicing and billing terms: 

  Tally provides flexible invoicing options.  It provides good features to 

computer billing terms like sales tax, discount, excise duty, etc. 

 

2. Sales and purchase orders: 

 

  Tally provides reports on sales and purchase orders. 

 

3. Rejection in and rejection out: 

  Tally provides separate voucher for sale/purchase returns.  Rejection in for 

sales return and rejection out for purchase return. 

 

4. Profitability analysis: 

  Tally calculates gross profits for each invoice, stock item, and stock group. 

   

 

 

10) How will you save, open and close a workbook? 
 

Saving a workbook: 

To save a workbook for the first time, we assign a file name and indicate 

where we want to store the file on our computer‟s hard disk or in another location.  
Each time we subsequently save the workbook, Microsoft Excel updates the 

workbook file with our latest changes. 

Save a new, unnamed workbook: 

1. On the File menu, click save as. 

2. In the save in list, select the drive and folder where we want to 

save the workbook.  To save the workbook in a new folder, click 

Create New Folder. 

3. In the File name box, type a name for the workbook. 

4. Click save. 

 

Opening a Workbook: 
1. Click open 



2. In the Look in list, click the drive, folder, or FTP location that 

contains the workbook we want to open, and then locate and 

double-click the folder that contains the workbook. 

3. Double-click the workbook we want to open. 

Closing a workbook: 

1) On the File menu, click close. 

2) To close all open workbooks without exiting the program, hold 

down SHIFT and click close All on the File menu. 

 

11) What are the areas of Applications? 
 

 Computers are becoming a part of our day today life.  Computer revolution is 

going to affect each one of us as a member of modern society.  Computers are 

everywhere, in Banks, Hospitals, Airlines, Businesses, computers are confined only by 

limitations on human creativity and imagination. 

 

Ranges of Applications 

 

Scientific Applications 

 

 The advent of information technology has greatly expanded research in sciences 

such as physics, chemistry, astronomy and genetics. 

 There is an increasing use of computers for research and data analysis in the fields 

of medicine, social sciences and humanities  

 Information technology helps in connecting computers in universities and 

laboratories. 

 Using Information Technology, 

 A chemical engineer can solve a set of simultaneous differential equations. 

 A civil engineer can analyze stress points in a bridge design 

 An electronic engineer can use computer as a tool in PCB design. 

 An industrial engineer can use it as a statistical package to investigate the 

interactions between number of defects and level of lighting. 

 A draftsman can use computer graphics to draw a particular design. 

 

Educational Applications 

 

 Most of the countries use IT to reform education and technology. 

 Computers are now used in classrooms as an aid to teach the students. 

 The interned could be used to enable students to take video field trips to distance 

places and pull out the information from remote museums and libraries. 

 Using IT, the distant learning is more improved by „Virtual University”. 
 Government and Electronic Democracy Applications 

 Used as a campaigning tool  

 Delivering government services 



 Public Electronic Network in us gives free access to the city people about council 

agendas, staff report, public safety tips and public library‟s online catalog. 
 People may also enter into electronic conference. 

 Electronic voting has raised the percentage of people to vote. 

Industrial Applications 

 

 In industry, production may be planned, coordinated and controlled with an 

associated work of branch managers using internet. 

 The operation of individual machine tools can be controlled via internet form 

remote systems. 

 Designs of a new product can be tested and exchanged with factories in remote 

locations. 

 

Business Applications 

 

 The electronic mail, in which people make purchases online. 

 Record companies are making sound excerpts and videos of new albums available 

on websites. 

 Wal-Mart and Microsoft have developed a joint online shopping venture that 

allows shoppers to browse online and buy merchandise. 

 Multilingual Applications 

 An application suggesting end user a list of languages to select his preferences to 

work. 

 A multilingual service presents a banner to choose a working language among 

several scripts. 

 

Medical Applications 

 

 The government is calling form an expansion of “telemedicine”, the use of 
telecommunications to link health-care providers and researchers, enabling them 

to share medical images, patient records and research. 

 Telemedicine allows long distance patient examinations by using video cameras.  

The virtual reality kinds of gloves help in transmitting and receiving tactile 

sensations. 

 

12) What is I-P-O cycle? Describe about I-P-O cycle? 
 

Input Process Cycle is the basic for most activities.  For example, take a car 

assembly line.  This activity constitutes the input part.  The process is the actual building 

of the car.  Therefore the process acts upon what has been the input and produces the 

output, which in the case would be the finished car.  Therefore the process acts upon what 

has been the input and produces the Output, which in this case would be the finished 

car. 

 

INPUT   >    PROCESS   >   OUTPUT 



 

The computer system follows the I-P-O Cycle.  This can be illustrated by a 

Railway reservation.  A person who wishes to travel by train between Chennai and 

Mumbai first has to fill in a request slip.  This slip contains relevant data, i.e., details of 

name, age, sex, boarding, destination, date of journey, number of persons etc.  The 

booking clerk keys in the data from the request slip into the computer. 

 

The process in this case includes examining the train number, the date of journey 

and the class requested.  The output of this process is the information confirming the 

booking, if seats are available.  Otherwise the computer turns down the request and issues 

a message. 

 

The data in the request slip is input into the computer via the keyboard.  Hence, 

the keyboard is an input device.  The processing is performed by a component of the 

system called the microprocessor.  The information regarding availability of seats is 

displayed on the VDU.  Hence, the VDU is an output device. 

 

 

 

13) List the Input and Output of the computer system. 
 

Input Device 

 

 It facilitates interaction between the users and computers.  This includes data 

presentation to the processing unit in machine-readable form. 

 It accepts data and information from the user. 

It converts these instructions and data into computer acceptable form. 

It passes the converted data and instructions to the computer for processing. 

There are four types of input devices: 

o Key driven devices 

o On-line devices 

o Source data automation devices 
o Direct-input devices 

 

Key driven devices: 

Punched Cards: 

 There are two types of punched cards.  One has 80 columns and the other has 96 

columns. 

1. 80 columns Card: 

 Divided from left to right into 80 columns numbered from 1 to 80 

 Each column of this card represents one character 

 Uses Hollerith code to represent data. 

 

2. 96 Column Cards: 

 There are 96 columns provided into 32 columns sections or tiers. 

 Uses BCD code to represent data. 



 

Paper Tape: 

 Data is coded on a paper tape in the form of punched hole combination. 

 The tape is normally 1 inch in width, and it comes in rolls. 

 Information is recorded as holes punched in the rows across the width of the tape 

with one row representing one character. 

 

On-line Devices; 

Keyboard: 

 In the case of key-driven devices data is first prepared using a separate device, but 

that is not necessary in the case of on line devices. 

 It is possible to communicate with the computer directly by using keyboard. 

 Same layout of typewriter is maintained in the keyboard.  Additional keys are 

included to perform special functions. 

 

Source Data Automation: 

 Source data automation is the term used to describe various means of inputting 

data directly form source material. 

 

 The three major technologies used in source data automation are: 

 Mark sensing 

 Magnetic Ink Character Recognition (MICR) 

 Optical Character recognition (OCR) 

 

Mark sensing; 

 This device recognize marks made in pencil or ink on a specially designed 

form or card 

 Detects the presence of any writing, but not the shape of the character. 

 

Magnetic Ink Character Recognition 

 MICR can read and interpret a single line to information printed in special 

ink that contains magnetic particles. 

 The most commonly used character set by MICR devices is known as E- 

13B character set. 

 

Bar Code Recognition: 

 Bar codes consist of light and dark lines arranged in a particular form. 

 Bar codes are used by retail traders for labeling shelves 

 This requires a uniform standard code read by equipment used in any store. 

 

Direct-Input devices: 

 Voice Input and Speech Recognition: 

 New methods to enter data at rapid rate are becoming popular, voice input is one 

such method, which does not require keyboard skills and technical training. 

 

Joystick: 



 It is a positioning device. 

 A small cursor displayed on the screen moves in response to users manipulation 

of the joystick. 

 

Mouse: 

Mouse is simple and low cost device, which is widely used, in graphical applications. 

 

Light Pen: 

 It is a pointing device. 

 If it is pointed at anywhere on the screen, the computer can identify the specific 

location to which the pen is pointing and determines the item selected by the user. 

 

Graphics Tablet 

 It is an input device used for tracing logos, map, cartoons etc.  It is a computer 

based terminal. 

 

Scanners 

 It is an input device that can read text or illustrations printed on paper and it 

translates the information into a form that the computer can use. 

 

 

Digital Camera 
 It is an input device used to input images into a computer. 

 

Output Devices 

 It receives information from the CPU in the machine readable form, convert them 

into human readable data and present it to the user.  The various output devices are 

 Monitor or Visual Display Unit 

 Printers 

 Plotters 

 

Monitor or Visual Display Terminals 

 It is otherwise known as “Display screen” 

 It displays the characters keyed in and helps in editing any program segment 

before storing them. 

 This uses a cathode ray tube to display information. 

It looks like a television screen. 

 

Graphics visual Display Unit (GVDU) 

 

 This VDU is able to display graphics, diagrams and alphanumeric characters. 

 Much more expensive than conventional VDUs. 

 

Printer 



 Printers are output devices that print the result of an operation on paper.  Printers 

are classified base don number of parameters like the mechanism used for printing, the 

speed of printing, and the quality of output. 

 

There are two types of printers. 

 Line printer. 

 Character printer. 

 

Printers that can print an entire line at a time and called “Line Printer” printers 

that can print only one character at time is called “Character printers”. 

 

Computer Output Microfilm: 

 Microfilm is a photographic film that records data in a greatly reduced size. 

 Documents on microfilms occupy one percent of space taken by originals. 

 

14) How will you create Business letter? 
 

 The Letter Wizard in Word can help us write a letter quickly and easily.  The 

wizard provides frequently used letter elements- such as salutations and closints- that we 

can select from lists.  The wizard also helps us to structure our letters based on frequently 

used letter styles. 

 

 Use the following procedure, which requires the Office Assistant, to create a letter 

with the Letter Wizard.  If we do not have the office Assistant installed, we can start the 

Letter Wizard by clicking New on the File menu, clicking the Letters and Faces tab, and 

then double-clicking Letter Wizard. 

 

 Type a salutation that starts with the word “Dear”, followed by a name and a 
colon or comma – such as Dear Thomas, or Dear board Members – and then press 

ENTER. 

 

 In the office Assistant, click Get help with writing the letter. 

 

 Follow the instructions in the letter wizard.  If we want to skip a step or go to a 

specific panel, click one of the tabs. 

 

15) Explain Complier and Interpreters. 
 

      COMPLIER 

 Complier is a program that translates source code into object code. 

 It checks the entire user-written program converts the whole into a 

machine language program. 

 After translating the entire program, it executes the program 

sequentially statement-by-statement and loads one statement at a 

time in core memory. 



 If any corrections occur in it, it asks for rectifications.  Hence the 

execution time is less in it. 

 All compiled programs run faster. 

 Any mistakes in the programs cannot be known at the time of 

entering instructions. 

 Objects code is generated here. 

 Useful for compiling large applications. 

 

Code security – When programs are executed using compilers, the code is highly 

secured.  The basic software on which the application software was developed is not 

needed at the time of implementation.  Thus the user has no need in seeing the source 

code. 

    

INTERPRETER 

The advantage of interpreter is that it can execute a program immediately. 

 The programs produced by a complier runs much faster than the 

same programs 

 Executed by an interpreter. 

 An intermediate form exists. 

 All interpreted programs runs a bit slow. 

 Errors will be known immediately. 

 Object code is not generated here. 

 It is used for small applications. 

 

No code security – When programs are executed using interpreter, the basic software on 

which this application software was developed is needed at the time of implementation.  

Thus the user can see the source code. 


